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1.1 Introduction

1.  This  course  should  emphasize  computational  skills  to  reinforce  the
analytical physics problem solving and use computer for modeling and
visualization. 

2.  Mathematica  will  be  applied  to  focus  on  mathematical  methods
needed for some courses in the physics  curriculum, mainly mechanics,
electricity and magnetism, and quantum mechanics. 

3. Mathematica is " A System for Doing Mathematics by Computer". It
is a powerful tool for learning, teaching and doing physics making it, in
some ways, an ideal computer assisted learning tool. 

4.  Mathematica  is  a  high  level  Programming  Language  developed  for
computation  and  doing  mathematics,  both  symbolic  and  numerical,
supported with powerful graphic capabilities. 



5.  It  has  sophisticated  tools  for  computer  graphics,  which  makes  it  an
ideal  computer  assisted  teaching  and  learning  tool,  with  the  ability  of
visualization and exploration.

6.  The course enhances the basic mathematical, numerical, and concep-
tual elements needed for using a computer-supported  learning environ-
ment as a virtual physics laboratory. 

7. It consists of a notebook front end interfaced to Kernel Program that
both allow a  suitable  media  for  integrated  presentation  of  calculations,
graphics, and documentation.   

8. The best way to study Mathematica is to keep the notebook opened,
key in the commands, and try out different examples. 
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1.2 Capabilities Of Mathematica

1.  Mathematica  is  a  high  level  Programing  language  which  allows
symbolical  and  numerical  calculations,  in  addition  to  mathematica
programming languages.

2.  Mathematica  can  be  used  as  both  a  presentation   environment  and  a
computational tool. 

3.  It  consists  of  a  notebook  front  end  interfaced  to  Kernel  Program  that
both  allow  a  suitable  media  for  integrated  presentation  of  :  calculations,
graphics, and documentation.   

4.  It  has  sophisticated  tools  for   computer  graphics,   which  makes  it  an
ideal  computer  assisted  teaching  and  learning  tool,  with  the  ability  of
visualization and exploration.

5. It allows to display two and three dimensional functions and data sets.

6.   Traditional  programming  languages  such  as  Basic  or  FORTRAN  are
good for doing numerical calculations, while with Mathematica  you can do
symbolic as well as numerical calculations. 

7.  Mathematica can also be used as a programing language. 

8.  It  has  over  700  built-in  functions,  and  allows  to  define  your  own
functions using mathematica programming language.

1.3 Getting Started With Mathematica 

1.3.1 Cell Brackets

When  you  open  up  Mathematica,  you  will  see  your  input  screen,  called  a  note-
book. When you begin typing commands, you'll notice that brackets appear on the
right  side  of  the  notebook.  These  are  called  cell  brackets.  Before  the  available
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memory becomes low, save the notebook and quit Mathematica or use Exit; other-
wise, Mathematica crashes and all the work is lost!   

1.3.2 Grouping Commands In One Bracket

Mathematica  may  be  different  than  some  programming  languages  you  have
worked  with  in  that  you  often  don't  run  an  entire  program  with  one  keystroke.
Instead you can put several different groups of commands in different cell brack-
ets, and you run each cell bracket individually.  It's a good idea to make an effort
to put the commands that tie together in the same bracket because it makes it eas-
ier to run the program again if you have fewer brackets. However, sometimes it is
necessary to run one command and not the other, and in this case you have to put
them in  separate  brackets.  You  can  do  this  by  clicking  below  the  last  command
with your pointer until you see a horizontal line. 

1.3.3 Running A Command

r

To get started type  some input command in the input cell,  then  put your cursor
anywhere on the input line and hit  Shift/ Enter, or enter in the numeric key board. 

ClearAll@"Global`∗"D
2 + 3

5

100!

93326215443944152681699238856266700490715968264381
6214685929638952175999932299156089414639761565182
8625369792082722375825118521091686400000000000000
0000000000
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Expand@Hx + yL^30D
x30 + 30 x29 y + 435 x28 y2 + 4060 x27 y3 + 27405 x26 y4 +

142506 x25 y5 + 593775 x24 y6 + 2035800 x23 y7 +

5852925 x22 y8 + 14307150 x21 y9 + 30045015 x20 y10 +

54627300 x19 y11 + 86493225 x18 y12 + 119759850 x17 y13 +

145422675 x16 y14 + 155117520 x15 y15 + 145422675 x14 y16 +

119759850 x13 y17 + 86493225 x12 y18 + 54627300 x11 y19 +

30045015 x10 y20 + 14307150 x9 y21 + 5852925 x8 y22 +

2035800 x7 y23 + 593775 x6 y24 + 142506 x5 y25 +

27405 x4 y26 + 4060 x3 y27 + 435 x2 y28 + 30 x y29 + y30

Integrate@1 ê HSin@x D^2 Cos@x D^3L, x D êê FullSimplify
1
2
I−2 Csc@xD − 3 LogACosA x

2
E − SinA x

2
EE +

3 LogACosA x
2
E + SinA x

2
EE + Sec@xD Tan@xDM

Plot3D@Sin@x y D, 8x , -Pi, Pi<, 8y , -Pi, Pi<,
PlotPoints Æ 25, ImageSize Æ 8200, 150<D;
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1.3.4 Commands Begin With Capital Letters

All built-in Mathematica commands start with a capital letter. 
Integrate@5 + 2 x - 3 x ^2, x D
5 x + x2 − x3

Plot3D@Sin@x y D, 8x, -Pi, Pi<, 8y , -Pi, Pi<, PlotPoints Æ 25D;

Expand@Hx + y L^30D
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1.3.5  Mathematica  Commands Are Spelled Out Completely

Almost  all  Mathematica   commands  are  spelled  out  completely  :  they  are  not
abbreviated. The common exceptions are Abs (absolute value), Re (real part), Im
(imaginary part), Sqrt (square root),  D (derivative) and Det (determinant). 

8Abs@5. + 6 I D, Sqrt@2.D, Re@5 + 6 I D, Im@5 + 6 I D,
Conjugate@5. + 6. I D, D@Cos@x D, x D, Det@881., 2.<, 83., 0<<D<

87.81025, 1.41421, 5, 6, 5. − 6. , −Sin@xD, −6.<

1.3.6  Square  Brackets

All Mathematica functions use square  brackets to enclose their arguments.

Plot@10 Exp@- x D Cos@10 * x D, 8x , 0, 5.<,
PlotRange Æ 880, 5<, 8-10, 10<<, ImageSize Æ 8200, 150<D;

1 2 3 4 5
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1.3.7  Curled  Brackets

Curled brackets are used to group functions, variables, and command options.

8Cos@Pi ê 3D, Pi, Sqrt@2D<
9 1
2
, π, è!!!2=

1.3.8  Parentheses

Parentheses are used to change the order of mathematical  operations.
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H2 + 3L ê H8 - 4L
5
4

1.3.9 Special Protected Symbols

Mathematica has a number of special protected symbols. The three most common
ones are I , which is :    I =è!!!!!!−1  , E , which is :  e = 2.71828 and Pi , which is  :  p
= 3.14159. You cannot use these symbols for anything else!

8Sqrt@-1D, I , ‰<
8 , , <

8Pi, p, „, E <
8Pi, p, „, E < êê N
8π, π, , <
83.14159, 3.14159, 2.71828, 2.71828<

1.4 The Drop Menus Ruler Command

1.4.1 The File Menu

The file menu  gives you a fairly standard list of options: open, close, new, save,
save as, print,  plus few others. 

1.4.2 The Edit Menu

The Edit menu gives you the standard cut, paste, and copy options as well as the
option to save selection in special format.

1.4.3 The Cell Menu

The cell menu controls the behavior of cells. 
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1.4.4 The Format Menu

The format menu controls the appearance of the contents of the cells. 

1.4.5 The Input Menu

The  Input  menu  allows  you  to  make  buttons,  palettes  and  hyperlinks.  It  also
allows  you  to  get  file  paths,  graphics  coordinates  and  three  dimensional  view-
points. 

1.4.6 The Kernel Menu

The  Kernel  menu  contains  commands  for  controlling  the  evaluation  of
expressions.

1.4.7 The Find Menu

The file menu has commands for finding and replacing strings in a notebook. 

1.4.8 The Window Menu

The  window  menu  controls  how  the  windows  for  the  notebooks  that  you  have
open are  displayed.

1.4.9 The Help Menu

To explore  the Help Browser,  choose Help  in  the Help menu. The help Browser
provides several types of help :

1.4.9.1 Built-In Functions

Built-in Functions : Information and examples on the built-in functions
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1.4.9.2 Add - Ons

Add-ons : Information and examples on functions defined in the standard 
packages.

1.4.9.3 The Mathematica Book

The Mathematica Book : On-line version of The Mathematica Book.

1.4.9.4 Master Index

Master Index : On-line search of all items in the help Browser.

1.4.9.5 Getting Started

Getting Started : On-line version of Getting Started with Mathematica.

1.4.9.6 Other Resources

Other Resources : Information about the menu commands and other Mathematica
resources.

1.4.9.7 Preparing Input

If  we type "Fou",  highlight  the characters,  and choose Complete Selection in the
Input  menu  the  full  name  appear   Fourier.  If  there  are  several  possible  comple-
tions,  a list  of the names is displayed. For example, if we type "Plot" and choose
Complete Selection, a menu will pop up giving all possible choices. Try them... 

Fou

Plot

If we type "Do", highlight the characters, and choose Template in the Input menu
to specify the number, type and location of its argument. For example, type "Do"
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and  choose  Template,  we  get  Do[expr,{imax}].  The  first  argument  is  an  expres-
sion; the second argument, an iterator.

Do

1.5 Notebook Interface

1.5.1 Notebooks

For notebook interfaces,  Mathematica documents are called notebooks. A Mathe-
matica  notebook contains ordinary text, Mathematica input and output, and graph-
ics.  Animated  graphics  can  be  produced  from  a  sequence  of  graphic  cells,  and
existing or modified input can be sent to the kernel for actual computations.

The basic unit of organization in a notebook is a cell. The bracket to the right of a
cell  marks  its  extent.  For  a  new  notebook,  a  new  cell  is  created  when  we  start
typing  as  the  one in  this  paragraph.  To produce another  cell  above or  below this
one  or  between  any  two  cells,  click  when  the  pointer  turns  into  a  horizontal
I-beam above or below this cell or between two cells and then type. 

1.5.2 Sending Input to Kernel

To send Mathematica input to the kernel, put the text insertion point anywhere in
the input  cell  or  highlight  the  cell  bracket,  and press  Shift+Enter  or  Enter  on the
numeric  keypad.  The  kernel  evaluates  the  input  and  returns  the  result  in  one  or
more cells below the input cell. 

1.5.3 Interrupting Calculations

To interrupt a calculation, choose Abort Evaluation in the kernel menu. Mathemat-
ica  aborts  the  current  calculation,  sometimes after  some delay,  and  we may con-
tinue with further calculations. If the kernel does not respond to this command, we
can interrupt the calculation by choosing Local or another appropriate item in the
Quit  Kernel  submenu of  the  Kernel  menu and clicking  Quit  in  the  dialog  box  to
disconnect  the  kernel  from  the  front  end  and  terminate  the  current  Mathematica
session. The notebook, however, is unaffected. Sending another input to the kernel
restarts the kernel and begin as new Mathematica session. 
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1.5.4 On Line Help

1.5.4.1 Question Mark

We  can  access  information  about  any  kernel  object  by  typing  a  question  mark
followed by the  name of  the object  and then pressing Shift+Enter  or  enter  in the
numpad. To get more information about an object use ?? instead of ?.

? Pi  
Info3587286086-1945646

Pi is the constant pi, with numerical
value approximately equal to 3.14159. More…

? DSolve
Info3587286115-3371102

DSolve@eqn, y, xD solves a differential
equation for the function y, with independent
variable x. DSolve@8eqn1, eqn2, ... <, 8y1,
y2, ... <, xD solves a list of differential
equations. DSolve@eqn, y, 8x1, x2, ... <D
solves a partial differential equation. More…

?? DSolve 
Info3587286140-9014139

DSolve@eqn, y, xD solves a differential
equation for the function y, with independent
variable x. DSolve@8eqn1, eqn2, ... <, 8y1,
y2, ... <, xD solves a list of differential
equations. DSolve@eqn, y, 8x1, x2, ... <D
solves a partial differential equation. More…

Info3587286140-9014139

Attributes@DSolveD = 8Protected<

Options@DSolveD = 8GeneratedParameters → C<
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1.5.4.2 Question Mark And Wild Card Character

When  used  in  conjunction  with  ?,  the  symbol  *  is  a  wild  card  that  matches  any
sequence of alphanumeric characters as : ?ND* , in this case the symbol * matches
"Solve" . If the specification matches more than one name, Mathematica returns a
list of the possible related names. 

? ND* 
Info3587286164-2495009

NDSolve@eqns, y, 8x, xmin, xmax<D finds a numerical
solution to the ordinary differential
equations eqns for the function y with the
independent variable x in the range xmin to
xmax. NDSolve@eqns, y, 8x, xmin, xmax<, 8t,
tmin, tmax<D finds a numerical solution to the
partial differential equations eqns. NDSolve@
eqns, 8y1, y2, ... <, 8x, xmin, xmax<D finds
numerical solutions for the functions yi. More…

? *Plot*

System`
ArrayPlot ListPlot Plot PlotLabel
ContourPlot ListPlot3D Plot3D PlotPoints
DensityPlot MaxPlotPoints Plot3Matrix PlotRange
ListContourPlot ParametricPlot PlotDivision PlotRegion
ListDensityPlot ParametricPlot3D PlotJoined PlotStyle

1.5.4.3 Command Key F1

Type a command and press F1 to get help on that command.

Plot

1.5.4.4 Operator Quarry

We can use ? to ask for information about most operator input forms. To obtain 
information on && , for example : ?&&.
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? &&
Info3587286235-9622911

e1 && e2 && ... is the logical AND function.
It evaluates its arguments in order,
giving False immediately if any of them are
False, and True if they are all True. More…

1.5.4.5 Library Package Quarry

Needs@"Graphics`Graphics`"D
<< Graphics`Graphics`

$Packages

8Utilities`FilterOptions`, Graphics`Common`GraphicsCommon`,
Graphics`Graphics`, Global`, System`<

? Graphics`Graphics`*

Graphics`Graphics`
BarChart LinearLogListPlot PieExploded
BarEdges LinearLogPlot PieLabels
BarEdgeStyle LinearScale PieLineStyle
BarGroupSpacing ListAndCurvePlot PieStyle
BarLabels LogGridMajor PiScale
BarOrientation LogGridMinor PolarListPlot
BarSpacing LogLinearListPlot PolarPlot
BarStyle LogLinearPlot ScaledListPlot
BarValues LogListPlot ScaledPlot
DisplayTogether LogLogListPlot SkewGraphics
DisplayTogetherArray LogLogPlot StackedBarChart
ErrorListPlot LogPlot TextListPlot
GeneralizedBarChart LogScale TransformGraphics
Histogram PercentileBarChart UnitScale
LabeledListPlot PieChart

Info3622144925-8729893

BarChart@list1, list2, ...D
generates a bar chart of the data in the lists. More…

Exit

H* to check to see what packages are installed *L
$Packages
8Utilities`FilterOptions`, Graphics`Common`GraphicsCommon`,
Graphics`Graphics`, Global`, System`<
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? Graphics`Graphics`* 

Graphics`Graphics`
BarChart LinearLogListPlot PieExploded
BarEdges LinearLogPlot PieLabels
BarEdgeStyle LinearScale PieLineStyle
BarGroupSpacing ListAndCurvePlot PieStyle
BarLabels LogGridMajor PiScale
BarOrientation LogGridMinor PolarListPlot
BarSpacing LogLinearListPlot PolarPlot
BarStyle LogLinearPlot ScaledListPlot
BarValues LogListPlot ScaledPlot
DisplayTogether LogLogListPlot SkewGraphics
DisplayTogetherArray LogLogPlot StackedBarChart
ErrorListPlot LogPlot TextListPlot
GeneralizedBarChart LogScale TransformGraphics
Histogram PercentileBarChart UnitScale
LabeledListPlot PieChart

? PolarListPlot
Info3587286393-5410302

PolarListPlot@8r1, r2, ...<D
generates a polar plot, assuming that
the ri are equally spaced in angle. More…

Clear@"Graphics`Graphics`"D
Clear@"Global`*"D
Needs @"Miscellaneous`PhysicalConstants`"D
<< Miscellaneous`PhysicalConstants`
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? Miscellaneous`PhysicalConstants`*  

Miscellaneous`PhysicalConstants`
AccelerationDueToGravity MuonMagneticMoment
AgeOfUniverse MuonMass
AvogadroConstant NeutronComptonWavelength
BohrRadius NeutronMagneticMoment
BoltzmannConstant NeutronMass
ClassicalElectronRadius PlanckConstant
CosmicBackgroundTemperature PlanckConstantReduced
DeuteronMagneticMoment PlanckMass
DeuteronMass ProtonComptonWavelength
EarthMass ProtonMagneticMoment
EarthRadius ProtonMass
ElectronCharge QuantizedHallConductance
ElectronComptonWavelength RydbergConstant
ElectronGFactor SackurTetrodeConstant
ElectronMagneticMoment SolarConstant
ElectronMass SolarLuminosity
FaradayConstant SolarRadius
FineStructureConstant SolarSchwarzschildRadius
GalacticUnit SpeedOfLight
GravitationalConstant SpeedOfSound
HubbleConstant StefanConstant
IcePoint ThomsonCrossSection
MagneticFluxQuantum VacuumPermeability
MolarGasConstant VacuumPermittivity
MolarVolume WeakMixingAngle
MuonGFactor

Exit H∗ to exit Kernel and
remove all packages and definitions ∗L

$Packages

8Global`, System`<

Chapter-1.nb 15



1.5.5 Creating A Document

1.5.5.1 Style Sheet

Open  a  new  notebook  and  use  the  FormatÆStyle  SheetÆOther...  to  change  to
the  SeanDefault.nb  style  sheet.  Mathematica  notebooks  are  separated  into  titles
with Titles, Subtitles  and Subsubtitles;   sections with Sections, Subsections  Sub-
subsections, and text and other types of cells.

If the BasicInput palette is not open, open it with FileØPalettesØBasicInput.  You
can see which windows are currently open and switch between windows by click-
ing  on  Window in  the  menu bar.   In  this  section  we will  be  using  BasicInput  to
write mathematical expressions in inline formulas and display formulas. The Basic-
Input palette contains buttons that give you two dimensional typset expressions.

To write a text in a notebook first indicate that the next cell should be a text cell
and  then  begin  typing.   You  can  choose  a  text  cell  in  several  ways:   select  For-
matØStyleØText from the menu bar, select Text from the pull-down menu in the
toolbar  or  for  Windows,  press  ‡Î7Ï.  Text  cells  can  be  left,  center,  right  or  full
justified.   You  can  select  these  options  through  the  toolbar  or  Format  pull-down
menu on the menu bar.  The text in the hint cells is full justified.

You  can  mix  text  and  mathematical  formulas  with  inline  formulas.   To  make an
inline formula in a text cell, press ‚Î9Ï,  type the formula, and then press ‚Î0Ï.
When  you  press  ‚Î9Ï,  a  highlighted  box  will  appear.   Type  the  formula  in  this
box as  you would  as  an input.   When you press  ‚Î0Ï,  the  formula will  become
unhighlighted and the cursor will move to the right of the formula.  

Note that if you type  a single character, Mathematica assumes it is a variable and
writes  it  in  italics.   If  you  type  two  or  more  characters  together,  Mathematica
assumes that it is a function name or a word and writes it in plain face font.  The
spacing in the formula is automatically adjusted to make it look good.

To make a cell that contains only an inline formula and no surrounding text, First
make  an  empty  text  cell  and  then  start  the  formula  with  ‚Î9Ï.   Pressing  ‡Î7Ï
‚Î9Ï  then  press  space  and  then  backspace  ad   ‚Î9Ï,  then  starting  the  formula
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Î Ï Î Ï
then end with  ‚Î0Ï.  

‡Î7Ï ¯ BACKSPACE  ‚Î9ÏLogâz=Log|z|+iâArgâz‚Î0Ï

Log z = Log » z » +i Arg z   

If you want to type  a formula with no surrounding text, it is best to use a Display
Formula  cell.  Select  Format  Ø  StyleØ  ÇDisplayFormula  from  the  menu,  choose
DisplayFormula from the toolbar  or press ‡Î0Ï  and type  DisplayFormula in the
pop-up window. Then type the formula as you would an input.

1.5.5.2 Greek Letters and Built-in Constants

In this section we will  introduce typing Greek letters and built  in constants using
keyboard  shortcuts.  Use  the  BasicInput  palette  for  formatting  as  indicated.  The
centered  formulas  are  Display  Formulas.  In  Mathematica  there  are  four  ways  of
inputting special characters.  

1) Click a button in a palette.

2) Type an escape key shortcut.  For b the shortcuts are ÂbetaÂ and ÂbÂ.

3) Type a LA TE  X  symbol between escape keys, like Â\betaÂ.

4)  Type  the  Mathematica  name  for  the  symbol,  like  \[Beta].   When  you  finish
typing the name, it will magically turn into the symbol.

Try the following ways of writing b in a Display Formula.

ÂbetaÂ ¯ ÂbÂ ¯ Â\betaÂ ¯ \[Beta]

Here is a table of escape key shortcuts for Greek letters.

β β β β

α ÂaÂ ν ÂnÂ Γ ÂGÂ
β ÂbÂ ξ ÂxÂ ∆ ÂDÂ
γ ÂgÂ π ÂpÂ Θ ÂThÂ
δ ÂdÂ ρ ÂrÂ Λ ÂLÂ
ε ÂeÂ σ ÂsÂ Π ÂPÂ
ζ ÂzÂ τ ÂtÂ Σ ÂSÂ
η ÂetaÂ φ ÂphiÂ Υ ÂUiÂ
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θ ÂthÂ ϕ ÂcphiÂ Φ ÂPhiÂ
κ ÂkÂ χ ÂcÂ Χ ÂCÂ
λ ÂlÂ ψ ÂyÂ Ψ ÂYÂ
μ ÂmÂ ω ÂoÂ Ω ÂOÂ

Below are  the  typset  forms of  five  Mathematica constants.  Note  that  the  double-
struck form of the exponential, ‰, and the square root of -1, Â, allow you to distin-
guish between these mathematical constants and the variables.

Character Input Meaning
π ÂpÂ Pi

ÂeeÂ E
° ÂdegÂ Degree

ÂiiÂ I
∞ ÂinfÂ Infinity

1.5.5.3 Subscripts,Superscripts and Fractions

Mathematica has the following control-key sequences for creating two dimen-
sional formulas.

‚Î6Ï Superscript position.

‚Î − Ï Subscript position.

‚Î2Ï Square root.

‚Î5Ï Switch between superscript and subscript or go to
the exponent position in a root.

‚Îê Ï Denominator in a fraction.

‚Î¯Ï Return from a special position or move to the right
of the current structure.

‚Î.Ï Select the next larger subexpression.
→ Move to the next character.
← Move to the previous character.

Example 1: 

x  ‚Î6Ï  2  ‚Î5Ï  n  ‚Î¯Ï+x  ‚Î6Ï  3  ‚Î¯Ï+y ‚Î-Ï  2  ‚Î¯Ï+x ‚Î6Ï  y
‚Î6Ï z ‚Î¯Ï ‚Î¯Ï
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Î Ï Î Ï Î Ï

xn2 + x3 + y2 + xy
z

Example 2 : Integrals , Sums , and Matrices

ÂintÂ ‚Î-Ïa ‚Î5Ïb ‚Î¯Ï sin ‚Î6Ï2‚Î¯Ï (x) ÂddÂ x.

Ÿa
bsin2 x  „ x

ÂsumÂ  ‚Î=Ïn=1 ‚Î5ÏÂinfÂ  ‚Î¯Ï  1  ‚Î/Ï  n‚Î6Ï2  ‚Î¯Ï  ‚Î¯Ï
= ÂpÂ ‚Î6Ï2 ‚Î/Ï 6 ‚Î¯Ï 

⁄n=1
∞ 1

n2 = π2

6

Select  the  J N  button  from  the  BasicInput.nb  window,  or  press  ‚˜ÎcÏ.

Use  the  Í  to  move  between  entries  of  the  matrix.   Use  the  Backspace  key  to
delete a column or a row.

For the right side of the equation, make a 2 μ 2 matrix.  Delete the parentheses that
enclose the matrix.  Add a left bracket before the matrix.

Start  with  matrices.   Add  rows  with  ‚ÎÁÏ;   add  columns  with  ‚Î,Ï.   Use  the
following LaTeX commands to make the ellipses:

Â\cdotsÂ ∫      Continuation of an expression

Â\vdotsÂ ª

Â\ddotsÂ ∏   

1 ‚Î/Ï 2 ÂpÂ ÂiiÂ ÂcccintÂ 1‚Î/Ï sin ¯ z ‚Î¯Ï ÂddÂz = 1

1.5.5.4 Mathematical Symbols

Example 3 : 

The Laplace transform of f Ht L is @f D ª Ÿ0
¶f Ht L ‰-s t  „ t .

Mathematica  has  script  and  double  struck  fonts.ÂscLÂ[f]  Â= = =Â  ÂintÂ
‚Î-Ï 0 ‚Î5Ï ÂinfÂ ‚Î¯Ï f(t) ÂeeÂ ‚Î6Ï-s ¯ t ‚Î¯Ï ÂddÂ t

Example 4 : 
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The Fourier transform of f HxL can be defined @f D ª 1ÅÅÅÅÅÅÅÅ2 p  Ÿ-¶
¶ f HxL ‰-Â w x  „ x.

ÂscFÂ  [  f  ]  Â=  =  =Â  1  Â/Â  2  ÂpÂ  ‚Î¯Ï  ÂintÂ  ‚Î-Ï  -ÂinfÂ
‚Î5Ï ÂinfÂ ‚Î¯Ï f(x) ÂeeÂ ‚Î6Ï -ÂiiÂ ¯ ÂoÂ ¯ x ‚Î¯Ï
ÂddÂ x

Example 5 : Double Strike

The set of integers is ; the set of real numbers is ; the set of complex numbers
is .

ÂdsZÂ; ÂdsRÂ; ÂdsCÂ.

Example 6 : The chain rule

f Hu,vL
x = ∂f

∂u  ∂u
∂x + ∂f

∂v  ∂v
∂x

ÂddÂ ‚Î/Ï ÂddÂ x  f(u,v) ¯ = ÂpdÂ f ‚Î/Ï ÂpdÂ u ¯  ÂpdÂ u
‚Î/Ï ÂpdÂ x ¯ + ÂpdÂ f ‚Î/Ï ÂpdÂ v ¯  ÂpdÂ v ‚Î/Ï ÂpdÂ
x ‚Î¯Ï .

Example 7 : The Laplacian

The  Laplacian  is  D u ª “ ÿ H“ uL.   In  2D  rectangular  coordinates  it  is
D f = fxx + fy y .

ÂDÂ ¯ ÂuÂ Â= = =Â ÂdelÂ Â.Â ( ÂdelÂ ¯ u )

ÂDÂ  ¯  ÂphiÂ  = ÂphiÂ  ‚Î-Ï  x  Â,Â  x ‚Î¯Ï  +  ÂphiÂ  ‚Î-Ï  y
Â,Â y ‚Î¯Ï

Example 8 : The Sum

Ordinarily,  Mathematica  will  not  let  you  use  the  top  and  bottom  positions  with
sums in inline formulas.  To force this, follow the sum with an invisible space and
select both the sum and the invisible space.  Then use the top or bottom position
as usual

20 Chapter-1.nb



ÂzÂ (2) = ÂsumÂ ÂsumÂ ‚Î.Ï ‚Î.Ï ‚Î=Ï n = 1 ‚Î5ÏÂinfÂ ‚Î¯Ï
1 ‚Î/Ï n‚Î6Ï2 ‚Î¯Ï ‚Î¯Ï = ÂpÂ ‚Î6Ï2 ‚Î/Ï 6 ‚Î¯Ï  

Example 9: Symbols

Escape ~ ~ Escape Ø  ≈

Escape ~ = Escape Ø  >

Escape ! = Escape Ø   ≠

Escape > = Escape Ø  ≥

Escape !> Escape Ø   u

Escape elem Escape Ø  œ

Escape vec Escape Ø  1

Escape cross Escape Ø  ä

Escape un Escape Ø  ‹
Escape inter Escape Ø  ›
Escape Ao Escape Ø  Å

Escape prod Escape Ø  ∏

Escape sum Escape Ø   ∑   

Escape => Escape Ø   fl
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1.5.5.5 Converting Mathematica to HTML

A Mathematica notebook can be saved as an HTML file that can be viewed with a
web  browser.  Select  FileØSave  As  SpecialØHTML.  In  the  pop  up  window first
make a new folder by clicking the new folder button. Give the folder a name that
describes  the  notebook.  Double  click  the  folder  icon  to  move  to  the  new folder.
Finally  type  in  the  name of  an  HTML file  that  describes  the  notebook,  (a  string
followed  by  the  ".htm"  extension,  like  "myfile.htm"),  and  click  on  Save.  It  may
take a little while to save in HTML format. Now open the HTML file using Naviga-
tor  or  Explorer.  You'll  use a command like FileØ  Open File.  Note that  each for-
mula, table and graphic is saved as a separate gif file.

Save this notebook as a HTML file and view it with a web browser. 

Now close the three sections and save this notebook as an HTML file in a differ-
ent folder.  Note that closed sections become links to separate pages.

With  the  current  version  of  Mathematica,  you  should  left-justify  all  the  cells
before saving as an HTML.file.  If they are not left-justified, the graphics will not
be saved correctly.

1.5.5.6 Notebook Page 

date1 = 8 8 "year", "month", "day" , "hour" <,
Drop@Date@D, −2D < êê Transpose êê TableForm

year 2013
month 9
day 4
hour 12

To apply text style of plotting for the rest of the notebook inter :

$TextStyle = 8FontFamily → "Times",
FontSize → 14, FontColor → RGBColor@0, 0, 0D<;
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Plot@Sin@xD, 8x, 0, 2 Pi<, AxesLabel → 8"x", "y"<,
PlotLabel → "Sin Function", ImageSize → 8200, 150<D;

1 2 3 4 5 6
x

-1
-0.5

0.5
1

y Sin Function

To apply precision 30 for the rest of the notebook inter :

Clear@"Global`∗"D
Off@General::spellD; Off@General::spell1D;
$Post = HN@#, 30DL &;

To Clear Definition :

$Post =.
$TextStyle =.

The  command  Rationalize[x,dx]  converts  x  to  an  exact  number  with  an  error
smaller in magnitude than dx.For example,

8 Rationalize@.296296, 1ê100 D, H∗Postfix notion∗L
.296296 êê Rationalize@#, 1ê100D &<
9 3
10

, 3
10

=

The  commands  Round[x]  returns  the  integer  closest  to  x,  Floor[x]  returns  the
greatest integer less than x, and Ceiling[x] returns the least integer greater than x.
Examples are,

8Round@3.5D, 3.5 êê Round,
Floor@3.5D, 3.5 êê Floor,

Ceiling@3.5D , 3.5 êê Ceiling <
84, 4, 3, 3, 4, 4<
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812312.348957, ScientificForm@12312.348957, 2D,
EngineeringForm@12312.348957, 3D,
NumberForm@12312.348957, 8D<

812312.3, 1.2×104, 12.3×103, 12312.349<

The random roll of a dies can be simulated by Mathematica command Random[-
Integer,{1,6}]. Define the roll of a dies

Clear@"Global`∗"D
data = Table@ Random@Integer, 81, 6<D, 8100<D
Mean@dataD êê N
H1 + 2 + 3 + 4 + 5 + 6Lê6.

86, 4, 4, 5, 5, 2, 4, 2, 2, 6, 4, 6, 4, 5, 2, 6,
5, 4, 6, 4, 2, 2, 2, 6, 4, 2, 2, 5, 5, 1, 6, 5,
3, 3, 6, 1, 6, 5, 4, 6, 3, 1, 4, 3, 5, 2, 3, 1, 5,
4, 5, 6, 2, 3, 6, 6, 2, 4, 5, 5, 3, 4, 4, 4, 3, 4,
4, 6, 6, 1, 4, 2, 4, 5, 4, 6, 2, 4, 5, 2, 5, 4, 2,
4, 5, 3, 1, 4, 1, 6, 4, 4, 4, 2, 6, 5, 1, 5, 3, 5<
3.88

3.5

Clear@"Global`∗"D
dice := Random@Integer, 81, 6<D
trials@n_D := Table@dice, 8n<D
data = trials@100 D
Mean@dataD êê N

82, 2, 4, 3, 4, 4, 6, 1, 5, 6, 6, 1, 6, 6, 6, 2,
1, 2, 4, 5, 6, 4, 4, 5, 4, 3, 4, 3, 6, 5, 5, 1,
5, 4, 3, 4, 6, 2, 2, 5, 2, 2, 1, 4, 4, 5, 1, 1, 3,
5, 5, 1, 5, 1, 4, 1, 1, 4, 5, 2, 1, 3, 4, 4, 4, 5,
6, 6, 4, 4, 3, 2, 5, 6, 2, 6, 3, 6, 3, 3, 5, 1, 4,
6, 4, 3, 1, 2, 6, 6, 2, 4, 5, 4, 4, 2, 1, 2, 5, 5<
3.66
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1.6 Common Mathematica Commands

Mathematica Commands can be written in general syntax as :

Command [ { expression 1, expression 2,.......}, Option 1, Option 2, ........] 

Where Mathematica command always starts with capital letter, expressions can be
equations,  functions,  list  of  data,  .....,  and  options  are  the  command  options.  In
order to inquire about the syntax of a certain command, use question mark before
the  command,  wild  card  character  can  be  used  to  check  for  similar  commands.
Options  of  the  command can alse  be  checked by typing  :  Options  [  Command ].
Examples :   

? Solve
Info3587287263-2923590

Solve@eqns, varsD attempts to solve
an equation or set of equations for the
variables vars. Solve@eqns, vars, elimsD
attempts to solve the equations for
vars, eliminating the variables elims. More…

Options@SolveD
8InverseFunctions → Automatic, MakeRules → False,
Method → 3, Mode → Generic, Sort → True,
VerifySolutions → Automatic, WorkingPrecision → ∞<

? Integrate
Info3587287301-3874149

Integrate@f, xD gives the indefinite
integral of f with respect to x. Integrate@
f, 8x, xmin, xmax<D gives the definite
integral of f with respect to x from xmin
to xmax. Integrate@f, 8x, xmin, xmax<,
8y, ymin, ymax<D gives a multiple definite
integral of f with respect to x and y. More…
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Options@IntegrateD
8Assumptions $Assumptions,
GenerateConditions → Automatic,
PrincipalValue → False<

? Plot
Info3587287336-6157088

Plot@f, 8x, xmin, xmax<D generates a
plot of f as a function of x from xmin
to xmax. Plot@8f1, f2, ... <, 8x, xmin,
xmax<D plots several functions fi. More…

Options@PlotD
9AspectRatio →

1
GoldenRatio

, Axes → Automatic,

AxesLabel → None, AxesOrigin → Automatic,
AxesStyle → Automatic, Background → Automatic,
ColorOutput → Automatic, Compiled → True,
DefaultColor → Automatic, DefaultFont $DefaultFont,
DisplayFunction $DisplayFunction, Epilog → 8<,
FormatType $FormatType, Frame → False,
FrameLabel → None, FrameStyle → Automatic,
FrameTicks → Automatic, GridLines → None,
ImageSize → Automatic, MaxBend → 10.,
PlotDivision → 30., PlotLabel → None, PlotPoints → 25,
PlotRange → Automatic, PlotRegion → Automatic,
PlotStyle → Automatic, Prolog → 8<, RotateLabel → True,
TextStyle $TextStyle, Ticks → Automatic=

? *Plot*

System`
ArrayPlot ListPlot Plot PlotLabel
ContourPlot ListPlot3D Plot3D PlotPoints
DensityPlot MaxPlotPoints Plot3Matrix PlotRange
ListContourPlot ParametricPlot PlotDivision PlotRegion
ListDensityPlot ParametricPlot3D PlotJoined PlotStyle
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From  the  help  minus,  you  can  search  for  different  Mathematica  commands  and
their syntax with some illustrative examples. In order to become familiar with the
frequently used commands, here are some examples : 

1.6.1 Lists: 

To be able to easily manipulate a large number of objects at once in your program,
using  a  list  is  necessary.{}  curly  braces  are  used  in  Mathematica to  denote  a  list
such as: x = {3,5,7} , y = {a,b,c}.

Sin@xD ê. x → 8Piê2, Pi, 3 Piê2, Pi<
81, 0, −1, 0<

t1 = Table@8x, Sin@xD<, 8x, 0, π ê2, π ê12<D êê N
TableForm@t1, TableHeadings → 88<, 8Angle x, Sin HxL<<D
880., 0.<, 80.261799, 0.258819<,
80.523599, 0.5<, 80.785398, 0.707107<,
81.0472, 0.866025<, 81.309, 0.965926<, 81.5708, 1.<<

Angle x Sin x
0. 0.
0.261799 0.258819
0.523599 0.5
0.785398 0.707107
1.0472 0.866025
1.309 0.965926
1.5708 1.

1.6.2 Equality: 

Most of the equality statements you use in Mathematica will be simple definitions
like:

x = 3    y = 2+x

However,  sometimes  rather  than  just  defining  the  equality,  you  will  want  to  test
two expressions to find out if they are equal. You can do this in Mathematica by
using two equal signs:

In: 1 == 1 ;    Out: True In: 1==2   ;   Out: False

A more frequent use of the double equals sign is in the Solve expressions, where
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the computer uses the equality test to solve equations.In:  Solve[2x == 6, x] ;    out
: x->3

1 1
1 2

True

False

Solve@2 x 6, xD
88x → 3<<

1.6.3 Defining a Function: 

Equality statements is used in Mathematica for simple definitions of a function:

f1 = Sin[x]    or  f2[x]=Cos[x] or the delayed definition f3[x_]:= Tan[x]

Remove@"Global`∗"D
f1 = Log@xD;
f2@xD = Log@xD;
f3@x_D := Log@xD;
8f1 ê. x → π ê4, f2@π ê4D,

f2@xD ê. x → π ê4, f3@π ê4D< êê N

8−0.241564, f2@0.785398D, −0.241564, −0.241564<

1.6.4 Substitution rule: 

The substitution rule is a very powerful tool in Mathematica. It removes the need
to constantly  redefine  variables  to  substitute  into expressions.  A substitution  rule
is written like this: 

Expression /. Variable -> value

x^2 /. x->2

By doing this you performed the operation without permanently assigning 2 to x. 

Another  valuable  use  for  substitution  rules  is  in  working  with  solutions  to  equa-
tions. 

sol = Solve[x^2-3y == 0, x]
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x^2 /. sol

It allows you to easily substitute other values into the solution. 

Clear@"Global`∗"D
sol = Solve@x^2 − 3 y 0, xD
x^2 ê. sol@@2DD
88x → −è!!!3 è!!!y<, 8x → è!!!3 è!!!y<<
3 y

1.6.5 Plotting: 

Plotting  is  usually  fairly  easy;  the basic syntax is  Plot[fx,{x,xmin,xmax}]. If  you
want  to  plot  a  list  of  values  you  can  use  ListPlot  the  same way,  and  to  make  a
parametric  plot  you  just  use  ParametricPlot[{fx,fy},{t,tmin,tmax}].  One  common
problem in plotting is caused when you try to plot a function that Mathematica has
not first evaluated; this will give you an error message. If you are having problems
plotting a function that you have defined in terms of another function, it is a good
idea to try using Evaluate in your plot command:  Plot [Evaluate [fx], {x, xmin,
xmax}, Options ]

Plot - Generates a basic plot of a function. It is written in the form 

  Plot [fx, {x, xmin, xmax}] 

ParametricPlot  -  Generates  a  parametric  plot  with  x  and  y  generated  as  a  func-
tion of t. It is written in the form 

  ParametricPlot [{fx, fy }, {t, tmin, tmax}] 

ListPlot - Plots a list of values on the y axis, considering the x coordinates to be 1,
2… It is written in the form 

  ListPlot  [{y1,  y2,..}]  or  to  specify  both  coordi-
nates ListPlot [{{x1,y1},{x2,y2}..}]
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Clear@"Global`∗"D
f1 = Cos@xD;
f2 = Sin@2 xD;
data1 =

880, 0<, 81, 2<, 82, 4<, 83, 9<, 84, 16<, 85, 25<<;
Plot@8f1, f2<, 8x, 0, 4 Pi<, ImageSize → 8200, 150<D ;
Plot@8f1 + f2<, 8x, 0, 4 Pi<, ImageSize → 8200, 150<D;
ParametricPlot@8f1, f2<,
8x, 0, 2 Pi<, ImageSize → 8200, 150<D;

ListPlot@data1, PlotStyle −> PointSize@0.03DD;

2 4 6 8 10 12

−1

−0.5

0.5

1

2 4 6 8 10 12

−1.5
−1

−0.5

0.5
1

1.5

−1 −0.5 0.5 1

−1

−0.5

0.5

1
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1 2 3 4 5

5

10

15

20

25

1.6.6 Clearing variables: 

Often you will have so many variables in a program that it would be very time-con-
suming to write separate commands to clear each when you want to run the pro-
gram again. Instead you can insert the command Remove["Global`*"] to clear all
variables.  If  you're  having  problems  with  your  program,  it  is  sometimes  a  good
idea to clear all the variables and then run it again, to make sure that in debugging
you didn't mess up the values of the variables.
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x1 = 6;
x1

Clear@x1D
x1

ClearAll@"Global`∗"D
x1

Remove@"Global`∗"D
x1

x1 =.
x1

6

Clear::ssym :  x1 is not a symbol or a string. More…

6

6

x1

Unset::norep :  

Assignment on Subscript for x1 not found. More…

$Failed

x1

1.6.7 Solve, DSolve, and NDSolve:

DSolve-Form of the Solve function used on a differential equation. It is written in
the basic form:  DSolve [equation, y, x], but initial conditions can also be added:

Dsolve [ {x''[t] + 4x[t] == 0, x[0] == 3, x'[0] == 0}, x, t]

NDSolve-Works in the same way as the DSolve, but returns a numerical solution.
It is written

NDSolve [ equation, y, {x, xmin, xmax}]

 NDSolve[{y'[x]  == y[x], y[0] == 1}, y, {x, 0, 2}]
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sol1 =

DSolve@8x''@tD + 4 x@tD 0, x@0D 3, x'@0D 0<, x, tD
sol2 = DSolve@8x''@tD + 4 x@tD 0,

x@0D 3, x'@0D 0<, x@tD, tD
x'@tD ê. sol1
x'@tD ê. sol2

88x → Function@8t<, 3 Cos@2 tDD<<
88x@tD → 3 Cos@2 tD<<
8−6 Sin@2 tD<
8x @tD<

Clear@y, x, sol1D
sol1 = NDSolve@8y'@xD y@xD, y@0D 1<, y, 8x, 0, 2<D
Plot@y@xD ê. sol1, 8x, 0, 2<, ImageSize → 8200, 150<D;

88y → InterpolatingFunction@880., 2.<<, <>D<<

0.5 1 1.5 2

1
2
3
4
5
6
7

1.6.8 Flatten:

This function "flattens"out nested lists by removing a set of {},it can be useful in
manipulating solutions to equations.  

 Flatten [{{x},{y,z}}]

Flatten@88x<, 8y, z<<D H∗ Prefix command ∗L
88x<, 8y, z<< êê Flatten H∗ Postfix command ∗L
8x, y, z<
8x, y, z<
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1.6.9 Simplify:

This function can put  expressions  into a form where they "look pretty";  it  tries a
bunch of different algebraic transformations like factoring and expanding to return
an expression in a simpler form.   Simplify[x2 + 2x +1]

Simplify@x^2 + 2 x + 1D
H1 + xL2

1.6.10 Evaluate:

This  function  evaluates  an  expression  that  Mathematica  would  normally  hold
unevaluated.  Evaluate  is  a  good thing  to  try  if  you're  having problems plotting  a
function:  In: Plot [Evaluate[v[t]],{t,0,10}] 

Clear@"Global`∗"D
x0 = 10; v0 = 2.; a = 1.5;
v@tD = v0 + a t;
x@t_D := x0 + v0 t + 1ê2 a t^2
Plot@Evaluate@8x@tD, v@tD<D,
8t, 0, 10<, ImageSize → 8200, 150<D;
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40

60
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1.6.11 Random :

This  function  generates  random real  numbers  between zero and  one,  or  a  certain
kind  of  number  (real,  integer,  complex .....)  within  a range specified  in  the  argu-
ment of syntax : Random [ Number, {min, max}]. 

8Random@D, Random@Real, 80, 100<D,
Random@Integer, 81, 6<D<
80.808852, 11.2038, 4<
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1.7 Mathematica Applications

Computers are becoming increasingly important in computational physics. The 
use of computer can be divided into the following categories :

1- numerical analysis

2- symbolic manipulation

3- simulation

4- collection and data analysis

5- visualization

1- numerical analysis : 

Mathematica is used as a simple calculator as well as a linear and differ-
ential  equation solver  by applying the appropriate  numerical  technique
for such a problem.

Example 1.1 

Calculate the volume of a cylinder of radius R = 2.1 cm, and of length
L = 8.5 cm

3.14 ∗ 2.1^2 ∗ 8.5

117.703

Clear@"Global`∗"D
R = 2.1 cm; L = 8.5 cm H∗Length of the cylinder∗L;
V = Pi ∗ R^2 ∗ L;
Print @ "Radius of the cylinder : R = ", RD
Print @ "Length of the cylinder : L = ", LD
Print @ "Volume of the Cylinder : V = ", VD
Radius of the cylinder : R = 2.1 cm

Length of the cylinder : L = 8.5 cm

Volume of the Cylinder : V = 117.763 cm3
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Example 1.2

Solve the following two linear equations to evaluate x and y : 2x + 3y =
18 ; x - y = 4 , using command Solve.

Clear@x, yD
Solve@82 x + 3 y 18, x − y 4<, 8x, y<D
88x → 6, y → 2<<

Clear@"Global`∗"D
eq1 = 2 x + 3 y 18;
eq2 = x − y 4;
sol1 = Solve@8eq1, eq2<, 8x, y<D êê Flatten
Print@"x = ", x ê. sol1@@1DDD
Print@"y = ", y ê. sol1@@2DDD
8x → 6, y → 2<
x = 6

y = 2

2- Symbolic Manipulation:

Mathematica  has  the  capability  of  symbolic  manipulation  as  well  as
analytical evaluation of algebraic problems. 

Example 1.3
Integrate the following expression : x Cos(x)

Clear@xD
Integrate@x Cos@xD, xD
Cos@xD + x Sin@xD

Example 1.4
Solve  algebraically  to  find  x  in  the  following  equation  :  ax2 +  bx  +  c  =  0,  using
command Solve.
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Clear@"Global`∗"D
sol = Solve@a x^2 + b x + c 0, xD
x ê. sol@@1DD

99x →
−b −

è!!!!!!!!!!!!!!!!!!!!b2 − 4 a c
2 a

=, 9x →
−b +

è!!!!!!!!!!!!!!!!!!!!b2 − 4 a c
2 a

==

−b −
è!!!!!!!!!!!!!!!!!!!!b2 − 4 a c
2 a

Example 1.5
Consider a mechanical system of two masses m1 and m2  are connected by a light
string  and  both  are  pulled  on  a  frictionless  horizontal  surface  with  an  external
applied  force  F,  as  shown in  the  figure.  Assume that  the  connecting  string  has  a
tension T, the applying Newton's second law to each block we obtain the follow-
ing two equations:

          F - T = m2 a      .......(1)

          T = m1 a           .......(2)

m1 m2 
F T T 

Clear@"Global`∗"D
eq1 = F − T m2 a;
eq2 = T == m1 a;
Solve@8eq1, eq2<, 8T<, aD
Solve@8eq1, eq2<, 8T, F<D
Reduce@8eq1, eq2<, 8T, F<D
Eliminate@8eq1, eq2<, aD
Solve@%, TD
99T →

F m1
m1 + m2

==

88T → a m1, F → a m1 + a m2<<
T a m1 && F a m1 + a m2

Hm1 + m2L T F m1

99T →
F m1

m1 + m2
==
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3- Simulation
In simulation of a physical system, a mathematical model of minimum analysis is
set to represent the behavior of such system. 

Example 1.6
Consider the simple physical system such as a pendulum. The application of New-
ton's  second  law  to  this  system  St  =  Ia,  will  give  the  second  order  differential
equation :

                            m 2d 2 q ê dt2 = -mg sinHqL; 
approximating sin(q) ~ q ; thus the differential equation becomes :

                            d 2 q ê dt2 = -Hg ê L q ;   or   

                             q
..
 + w2 q = 0 ; 

which has a solution

                            q(t) = C Sin Hwt + dL ; 

with the initial conditions at t = 0 we have q = q0 and dq/dt=0; the analytical solu-
tion to this system becomes :

                            q(t) = q0 Cos HwtL ,                were  w = "#####gÅÅÅÅÅ .

In  this  case  the  solution  giving  q  as  a  function  of  time  is  a  mathematical  model
which represents how q changes with time. This behavior can be represented graph-
ically and by animation.

Clear@"Global`∗"D
eq1 = m ^2 θ''@tD + m g θ@tD == 0;
eq2 = θ'@0D == 0;
eq3 = θ@0D == θ0;
sol1 = DSolve@8eq1, eq2, eq3<, θ@tD, tD
θ@t_D = θ@tD ê. sol1@@1DD;
Print@"θHtL = ", θ@tDD

99θ@tD → θ0 CosA
è!!!g t
è!! E==

θHtL = θ0 CosA
è!!!g t
è!! E
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Graphics Representation And Visualization

We can  see  the  animation  of  this  system  by  drawing  the  pendulum  in
frames at different time intervals then display these frames sequentially
to get a movie that represents the system kinematics as follows.

initialvalues = 8g −> 9.8, −> 1, θ0 −> Piê12<
Plot@θ@tD ê. initialvalues, 8t, 0, 6<, ImageSize → 8200, 150<D;
Plot@θ'@tD ê. initialvalues, 8t, 0, 6<, ImageSize → 8200, 150<D;

9g → 9.8, → 1, θ0 →
π
12

=
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Picture Animation And Visualization

We can  see  the  animation  of  this  system  by  drawing  the  pendulum  in
frames at different time intervals then display these frames sequentially
to get a movie that represents the system kinematics as follows.

g1 = 8Hue@0.8D, Thickness@0.15D,
Disk@8 Sin@θ@tDD, − Cos@θ@tDD< ê.

initialvalues, 0.05D<;
g2 = 8Hue@0.7D, Rectangle@8−0.3, 0<, 80.3, 0.1<D<;
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g3 = 8Hue@0.8D, Thickness@0.015D,
Line@880, 0<, 8 Sin@θ@tDD, − Cos@θ@tDD< ê.

8g −> 9.8, −> 1, θ0 −> Piê12<<D<;
p1 := Show@Graphics@8g1, g2, g3<, Frame −> True,

ImageSize → 8400, 300<,
AspectRatio → Automatic, Axes → False,
FrameTicks → 88−0.4, 0, 0.4<, 8<, 8<, 8<<,
FrameLabel −> 8"", "", "Simple Pendulum", ""<,
TextStyle −> 8FontFamily → "Times", FontSize → 14,

FontColor −> Hue@0.7D<, FrameStyle →

88RGBColor@1, 0, 0D, Thickness@0.015D<,
8RGBColor@1, 0, 0D, Thickness@0.01D<<,

PlotRange −> 88−0.5, 0.5<, 8−1.2, 0.2<<,
DisplayFunction → IdentityDD;

p2 := Plot@π ê12 Cos@Sqrt@9.8D tD, 8t, 0, 4 <,
PlotStyle → 8Hue@0.7D, Thickness@0.02D<,
Frame → True, FrameLabel −> 8"Time",

"Amplitude θHtL", "Sinusoidal Function", ""<,
TextStyle −> 8FontFamily → "Times",

FontSize → 14, FontColor −> Hue@0.65D<,
AxesStyle → 8RGBColor@1, 0, 0D, Thickness@0.015D<,
Epilog → 8PointSize@0.1D, Hue@0.8D,

Point@8t, π ê12 Cos@Sqrt@9.8D tD<D<,
ImageSize → 8400, 300<, PlotRange −>

880, 4<, 8−π ê10, π ê10<<, FrameTicks →

880, 2, 4<, 8−π ê12, 0, π ê12<, 8<, 8<<, FrameStyle →

88RGBColor@1, 0, 0D, Thickness@0.015D<,
8RGBColor@1, 0, 0D, Thickness@0.015D<<,

DisplayFunction −> IdentityD;
Table@Show@GraphicsArray@8p1, p2<D,

ImageSize −> 8400, 300<, DisplayFunction −>

$DisplayFunctionD, 8t, 0, 4, 0.1<D;
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4- Collection and Data Analysis

A real physical system can be simulated by a model which behave exactly as the
physical system and follow the same rules. Therefore, any data obtained from this
model will describe and represent this system. As an example, tossing two dies to
obtain two random integer numbers 1 to 6. This physical system can be simulated
and  modeled  by  a  computer  random  number  generator.  However,  computer  has
the  advantage  of  generating  large  amount  of  trials  and  data  collection,  storing
data, and data analysis much faster than tossing two dies, recording numbers and
counting processes. Consider the following example:

Example 1.7

Throw two dies for 10000 times and find the probability of getting a number 6 on
one or both dies. Find the average value of these throws. 

Solution

This  problem  can  be  modeled  and  simulated  by  generating  two  random  integer
numbers from 1 to 6, representing the numbers obtained by two dices. The process
is  repeated 10000 times so that  in  each time two numbers are recorded.  Then all
possibilities  of  getting  one  or  both  numbers  equal  to  6  are  counted,  then divided
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by to total number of trials 10000, to obtain the required probability. This method
can also  be considered  as  a  method for  collection  and  data analysis  for  a  system
that is simulated by random number generator rather than real dice tossing.

Clear@"Global`∗"D
n = 0; m = 10000;
x := Random@Integer, 81, 6<D
y := Random@Integer, 81, 6<D
l1 = Table@8x, y<, 8i, 1, m<D;
For@i = 1, i ≤ m, If@l1@@i, 1DD >= 6 fi l1@@i, 2DD >= 6,

n = n + 1, n = nD; i++D
nê m êê N

0.3022

Example 1.8 / Radioactivity

Consider a radiative sample in an experiment were the number of counts given by 
a radiation detector-counter system is recorded every 10 second, and data of 
{Time,Counts} are given in the following table:

data = 
{{10,264},{20,190},{30,152},{40,110},{50,78},{60,57},{70,39},{80,31},{90,20
},{100,15}};

Plot the data and fit these results to an exponential function. 
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Clear@"Global`∗"D
data = 8810, 264<, 820, 190<, 830, 152<, 840, 110<,
850, 78<, 860, 57<, 870, 39<, 880, 31<, 890, 20<, 8100, 15<<;

p1 = ListPlot@data, PlotRange → 880, 100<, 80, 300<<,
PlotStyle → PointSize@0.02DD;

f1 = FindFit@data, a0 Exp@−λ tD, 8a0, λ<, tD
p2 = Plot@a0 Exp@−λ tD ê. f1, 8t, 0, 100<D;
Show@p1, p2D;
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8a0 → 358.406, λ → 0.0303788<
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Example 1.9  / Theoretical model of Radioactivity
Consider  nuclear  decay  in  a  radioactive  system.  Select  a  model  to  simulate  this
radioactive  system  and  study  the  radioactivity  process  by  this  model  and  plot
decay  rate  with  time,  and  compare  the  results  with  analytical  solution.  Consider
that  the fundamental  law of  radioactive decay is  that  the rate of  decay is  propor-
tional to the number of nuclei.

Analytical Solution

Consider  a  large  number  of  radioactive  nuclei.  Although  the  number  of  nuclei  is
discrete,  we  can  treat  this  number  as  a  continuous  variable  since  the  number  of
nuclei is considerably large. The fundamental law of radioactive decay is that the
rate of decay (activity) is proportional to the number of nuclei. This can be written
mathematically as :

                  dNÅÅÅÅÅÅÅÅdt = -lN 

where N is the number of nuclei at any time t, and l is the decay constant of radio-
activity. This is a first order differential equation which can be solved analytically
by direct integration, with one initial condition at t=0 N = N0; so :

                       ŸN0

N dNÅÅÅÅÅÅÅÅN = -l Ÿ0
t dt     which gives :

                   N = N0 e-lt     an exponential decay function.

The half-life time t1ê2 is the time for the number of radioactive nuclei drop to half,
N = N0ÅÅÅÅÅÅÅ2 . Therefore, t1ê2 = ln2ÅÅÅÅÅÅÅÅl .         
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Solution of First Order Differential Equation Using Mathematica  Commands

Clear@"Global`∗"D
n0 = 50000; λ = 0.03;
sol1 = DSolve@8n'@tD −λ n@tD, n@0D n0<, n@tD, tD;
n@t_D = n@tD ê. sol1@@1DD
Plot@n@tD, 8t, 0, 100<D;

50000 −0.03 t
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Example 10  / Radioactivity Solution Using Modeling And Simulation

This problem can be modeled and simulated by considering a large identical num-
ber  of  unstable  nuclei  n0.  We  assume  that  during  any  time  interval  Dt,  each
nucleus  has  the  same probability  p  of  decaying.  Choose  un unstable  nucleus  and
generate a random number r uniformly distributed in the unit  interval 0 ≤  r ≤   1.
If r ≤  p , then the unstable nucleus decays; otherwise, it does not. Every unstable
nucleus is tested during each time interval. Once a nucleus decays, it is no longer
in  the  group  of  unstable  nuclei  that  is  tested  at  each  time  interval.  The  program
nuclear decay which implement this algorithm, is listed below.
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H∗ Nuclear − Decay ∗L
Remove@"Global`∗"D

n0 = 1000; tm = 100; p = 0.03; na = n0; ncum@0D = n0;
For@i = 1, i ≤ n0, i++, n@iD = 1D

For@t = 1, t ≤ tm, t++, 8For@i = 1, i ≤ n0, i++,
8If@Random@D ≤ p fl n@iD ≥ 1, 8n@iD = 0, na = na − 1<,

n@iD = n@iDD, ncum@tD = na<D<D
t1 = Table@ncum@tD, 8t, 1, tm<D;
p1 = ListPlot@t1, PlotStyle −> PointSize@0.02D,

DisplayFunction → IdentityD;
p2 = Plot@n0 Exp@−p tD, 8t, 0, tm<,

PlotRange → 880, 100<, 80, 1000<<,
PlotStyle → 8Hue@0.8D, Thickness@0.015D<,
DisplayFunction → IdentityD;

Show@p1, p2, DisplayFunction → $DisplayFunctionD;
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For better results of simulation, we may repeat the experiment for larger number 
of nuclei, or repeating the experiment number of times then take the average as 
follows.
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Clear@"Global`∗"D

n0 = 1000; tm = 100; ntrial = 10; p = 0.03;
For@t = 1, t ≤ tm, t++, ncum@tD = 0D
For@j = 1, j ≤ ntrial, j++,
8For@i = 1, i ≤ n0, i++, n@iD = 1D,

ncum@0D = ncum@0D + n0, nu = n0,
For@t = 1, t ≤ tm, t++, 8For@i = 1, i ≤ n0, i++,

8If@Random@D ≤ p fl n@iD ≥ 1, 8n@iD = 0, nu = nu − 1<,
n@iD = n@iDD<D, ncum@tD = ncum@tD + nu<D<D

t1 = Table@ncum@tDêntrial, 8t, 1, tm<D;
p1 = ListPlot@t1, PlotStyle −> PointSize@0.02D,

DisplayFunction → IdentityD;
p2 = Plot@n0 Exp@−p tD, 8t, 0, tm<,

PlotRange → 880, 100<, 80, 1000<<,
PlotStyle → 8Hue@0.8D, Thickness@0.015D<,
DisplayFunction → IdentityD;

Show@p1, p2, DisplayFunction → $DisplayFunctionD;
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5- visualization. 

Visual representation including both graphical and animation increases our under-
standing of the nature of analytical solutions. For example we know that :

                       sin (x) = x - x3
ÅÅÅÅÅÅÅ3! + x5

ÅÅÅÅÅÅÅ5! - x7
ÅÅÅÅÅÅÅ7! + ... ... ....

But  we  intend  to  think  if  the  Sin  function  as  a  periodic  function  of  sinusoidal
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graph rather than a mathematical function. This is because human eye in conjunc-
tion  with  the  brain  can  be  more  efficient  in  analyzing  visual  information.  That's
why it is important for each physical system to do the mathematical modeling and
obtain  that  mathematical  results  and  to  express  these  results  graphically  and  in
animated representation to help visualize these results. The following is an exam-
ple on projectile motion in two dimensions.                        

<< Graphics`Arrow`

Remove@"Global`∗"D
$TextStyle = 8FontFamily −> "Times", FontSize → 14<;

v0 = 40; g = 9.8; θ = π ê3; tm = 2 v0 Sin@θDêg;

x = v0 Cos@θD t;
y = v0 Sin@θD t − 0.5 g t2;
vx = D@x, tD;
vy = D@y, tD;

p1 = ParametricPlot@8x, y<, 8t, 0, tm<,
PlotStyle → 8Hue@0.9D, Thickness@0.01D<,
AxesLabel → 8"x", "y"<,
PlotRange → 880, 150<, 80, 70<<,
AspectRatio → 1.0, DisplayFunction → IdentityD;

vel = Graphics@88Hue@0.8D, Arrow@8x, y<, 8x + vx, y<,
HeadScaling → RelativeD<, 8Hue@0.8D, Arrow@
8x, y<, 8x, y + vy<, HeadScaling → RelativeD<<D;

pr = Graphics@
8Hue@0.7D, PointSize@0.08D, Point@8x, y<D<D;

tx = Graphics@Text@"θ = 60o ", 810, 5<, 8−1, 0<DD;
Do@Show@p1, vel, pr, tx, DisplayFunction →

$DisplayFunctionD, 8t, 0, tm, 0.05 tm<D;
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1.8 Loading Packages

Packages  contain  commands  that  are  not  as  often  used  as  the  commands  in  the
kernel.The  standard  packages  of  Mathematica  are  divided  into  groups  according
to  the  subject  area  of  the  packages.The  packages  can  be  found  with  the  Help
Browser.  Go to  Help @  Help Browser…and  then to Add-ons  and Links@Standard
Packages. The basic loading command is <<. Note that << is equivalent to the Get
or Needs.["name"]

Consider the package Miscellaneous`PhysicalConstants` and load it

Needs@"Miscellaneous`PhysicalConstants`"D

Names@"Miscellaneous`PhysicalConstants`∗"D êê Shallow

8AccelerationDueToGravity,
AgeOfUniverse, AvogadroConstant, BohrRadius,
BoltzmannConstant, ClassicalElectronRadius,
CosmicBackgroundTemperature, DeuteronMagneticMoment,
DeuteronMass, EarthMass, 41 <
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8 AgeOfUniverse,
AccelerationDueToGravity , AvogadroConstant< êê N

94.7×1017 Second, 9.80665 Meter
Second2

, 6.02214×1023

Mole
=

Needs@"Miscellaneous`Units`"D

? Convert
Info3587288235-1432460

Convert@old, newD converts old to a form
involving the combination of units new. More…

8Convert@AgeOfUniverse , Day D ,
Convert@AgeOfUniverse , Month D,

Convert@AgeOfUniverse , Year D,
Convert@AgeOfUniverse , Century D<

85.43981×1012 Day, 1.78843×1011 Month,
1.49036×1010 Year, 1.49036×108 Century<

Needs@"Miscellaneous`ChemicalElements`"D
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elements =

8Hydrogen, Helium, Lithium, Beryllium, Boron,
Carbon, Nitrogen, Oxygen, Fluorine, Neon, Sodium<;

abb = Abbreviation@elementsD;
melting = MeltingPoint@elementsD;
boiling = BoilingPoint@elementsD;
t1 = Transpose@8 abb , melting , boiling <D;
TableForm@t1, TableHeadings →

8elements, 8Abbrev , MeltingP, BoilingP<<,
TableSpacing → 81, 5<D ê. Kelvin → K

MeltingPoint::form :  Melting point is for the diamond form of Carbon.

Abbrev MeltingP BoilingP
Hydrogen H 14.01 K 20.28 K
Helium He 0.95 K 4.216 K
Lithium Li 453.69 K 1620. K
Beryllium Be 1551. K 3243. K
Boron B 2573. K 3931. K
Carbon C 3820. K 5100. K
Nitrogen N 63.29 K 77.4 K
Oxygen O 54.8 K 90.19 K
Fluorine F 53.53 K 85.01 K
Neon Ne 24.48 K 27.1 K
Sodium Na 370.96 K 1156.1 K
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Table@ 8Elements@@iDD, AtomicNumber@Elements@@iDDD,
IonizationPotential@ElementsD@@iDD,
SpecificHeat@ElementsD@@iDD< ,
8i, 1, 10<D êê TableForm

IonizationPotential::unknown :  

The ionization potential of Astatine is not known.

IonizationPotential::unknown :  

The ionization potential of Francium is not known.

IonizationPotential::unknown :  

The ionization potential of Lawrencium is not known.

General::stop :  Further output of IonizationPotential::unknown will
be suppressed during this calculation. More…

SpecificHeat::unknown :  The specific heat of Technetium is not known.

SpecificHeat::unknown :  The specific heat of Promethium is not known.

SpecificHeat::unknown :  The specific heat of Polonium is not known.

General::stop :  Further output of SpecificHeat::unknown will
be suppressed during this calculation. More…

Hydrogen 1 13.598 ElectronVolt 14.304 Joule
Gram Kelvin

Helium 2 24.587 ElectronVolt 5.193 Joule
Gram Kelvin

Lithium 3 5.392 ElectronVolt 3.582 Joule
Gram Kelvin

Beryllium 4 9.323 ElectronVolt 1.825 Joule
Gram Kelvin

Boron 5 8.298 ElectronVolt 1.026 Joule
Gram Kelvin

Carbon 6 11.26 ElectronVolt 0.709 Joule
Gram Kelvin

Nitrogen 7 14.534 ElectronVolt 1.04 Joule
Gram Kelvin

Oxygen 8 13.618 ElectronVolt 0.918 Joule
Gram Kelvin

Fluorine 9 17.423 ElectronVolt 0.824 Joule
Gram Kelvin

Neon 10 21.565 ElectronVolt 1.03 Joule
Gram Kelvin

Needs@"Statistics`DataManipulation`"D

? Statistics`DataManipulation`*

Statistics`DataManipulation`

BinCounts ColumnJoin LengthWhile

BinLists ColumnTake QuantileForm

BooleanSelect CumulativeSums RangeCounts

CategoryCounts DropNonNumeric RangeLists

CategoryLists DropNonNumericColumn RowJoin

ColumnDrop Frequencies TakeWhile
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Needs@"Graphics`Graphics`"D

Names@"Graphics`Graphics`∗"D
8BarChart, BarEdges, BarEdgeStyle, BarGroupSpacing, BarLabels,
BarOrientation, BarSpacing, BarStyle, BarValues, DisplayTogether,
DisplayTogetherArray, ErrorListPlot, GeneralizedBarChart, Histogram,
LabeledListPlot, LinearLogListPlot, LinearLogPlot, LinearScale,
ListAndCurvePlot, LogGridMajor, LogGridMinor, LogLinearListPlot,
LogLinearPlot, LogListPlot, LogLogListPlot, LogLogPlot, LogPlot, LogScale,
PercentileBarChart, PieChart, PieExploded, PieLabels, PieLineStyle,
PieStyle, PiScale, PolarListPlot, PolarPlot, ScaledListPlot, ScaledPlot,
SkewGraphics, StackedBarChart, TextListPlot, TransformGraphics, UnitScale<

Clear@"Global`∗"D
trials@n_D := Table@Random@Integer, 81, 6<D, 8n<D
data = trials@10000D;
datamean = Mean@dataD êê N
freq = Frequencies@dataD;
BarChart@Frequencies@dataD D;
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1.9 Problems

(1) Start Mathematica notebook and do the following :

    -  Add to  the  page the  toolbars  and  the  ruler  from the  format  menu -  Show
Toolbar & Show Ruler.

    - Type the following as a title in maginta color :     " Computational Physics "

    - Type the following as a subtitle in blue color :     " Lab Report 1 "

    -  Type  the  following  as  a  subsubtitle  in  red  color  :    "  Student's  Name  :
.................

                                                                                Students Number : ..............

                                                                                E-Mail  : .................   "

    - Use input Mathematica command Date and run to get the date and time at this
moment, then try to exclude seconds in the output using Drop command.

    - Type the following as a Section at the center of the page : " Problem Solutions
".      

    - Type the following as a subsection : " Solution Problem 1 "    

(2) Type an expression of the complementary error function as :

        erfc I xÅÅÅÅÅÅÅÅÅè!!!2 M = "#####2ÅÅÅÅp  Ÿx
¶e-t 2ê2 dt

(3)  Type  Rodriques'  formula  as  a  generating  function  of  Legendre  Polynomials
given as :

        P HxL = 1ÅÅÅÅÅÅÅÅÅÅ2  !
dÅÅÅÅÅÅÅÅ
dx

Hx2 - 1L
        

(4) Type the following definition of the curl of the vector V in cylindrical coordi-
nates in text form :

         —
”÷÷

äV”÷÷÷ =  

ƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒ

er req ez
∑ÅÅÅÅÅÅ∑r

∑ÅÅÅÅÅÅ∑q
∑ÅÅÅÅÅÅÅ∑z

Vr rVq Vz

ƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒ
 =

è r  H 1ÅÅÅÅr  ∑VzÅÅÅÅÅÅÅÅÅÅ∑q - ∑VqÅÅÅÅÅÅÅÅÅ∑z L + èq H ∑VrÅÅÅÅÅÅÅÅÅ∑z - ∑VzÅÅÅÅÅÅÅÅÅÅ∑r L + 1ÅÅÅÅr è z  H ∑HrVqLÅÅÅÅÅÅÅÅÅÅÅÅÅÅ∑r - ∑VrÅÅÅÅÅÅÅÅÅ∑q L         
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(5)  Determine  the  length  a  and  b  of  the  triangle  shown  in  the

figure. a 

b 

400

35o

(6)  Evaluate  the  following  :

33ê2 "################73 + 1ÅÅÅÅÅÅÅÅ8.5 Log H3.4L tan H30°L e-0.3 ëè!!!!!!!!!63.5     

(7) Solve the following linear equations using Mathematica command Solve :

               x + y = z

               10 - 6x - 2z = 0

               6x - 24 - 4y = 0

               

(8)  Use the Mathematica  command Coefficient  to  make a list  of  the coefficients
of the equation : 2x - 5.2 x2+ 6.1 x3- 3.4 x4        

(9)  A  (1.0  mole)  sample  of  an  ideal  gas  is  kept  at  (273  K)  during  an  expansion
from (3.0 LØ10.0 L). Given the gas constant R = 8.31 J/mol K , how much work
is done on the gas during the expansion? Work = - n R T Ln I vfÅÅÅÅÅÅÅvi

M .             

(10) Load the Miscellaneous`PhysicalConstants`  Library, and Check its content.
List  the  values  of  the  first  five  physical  constants  in  table  form indicating  in  the
first  column and the  value in the  second column using the  command Table,  and
the option TableHeadings.

(11) Load the Miscellaneous`ChemicalElements`  Library, and Check its content.
List the values of the first ten Elememts  and  in table form and the Abreviation,
AtomicNumber, ElectronConfigurationFormat, MeltingPoint, and the Boiling-
Point,  indicating  the  definition  of  each  row  and  column  using  the  command
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Table, and the option TableHeadings. 

(12) Neglect air resistance and consider a particle tossed upward from the surface
of the Earth.From the conservation of energy it follows that the sum of the kinetic
and  potential  energies  are  constant.  Use  the  conservation  of  energy  to  determine
the  escape  speed  of  the  particle  in  meter/second  and  in  miles/sec  units.  Use  the
add-on  packages  Miscellaneous`PhysicalConstants`  and  the  Miscellaneous`-
Units` to obtain the values : G = UnivesalGravitationalConstant, and M = Mass-
OfEarth, and to make unit conversion using the command Convert. 

(13) A ball is thrown vertically upward with an initial velocity of 20 m/s. Use the
command Table  to  tabulate  the  values  of  time,  velocity  and  position  of  the  ball
during  the  first  3  seconds  in  each  0.2  second  interval  of  time,  use  the  command
TableForm  with  option  TableHeadings,  and  use  ScientificForm  to  write  num-
bers  in  3  digits.  Make  a  plot  of  velocity  versus  time,  and  position  versus  time
graph.  

(14)  A  projectile  is  projected  under  force  of  gravity  with  an  initial  velocity
v0 = 20 m ê s, making an angle q=600  with the horizontal.  From kinematic equa-
tions  define  the  functions  x[t]  and  y[t].  Use  the  ParametricPlot  Mathematica
command to  make a  plot  for  a  projectile  motion  in  two  dimensions  for  the  time
interval 4 s. 

(15) Use Mathematica command Random[ ] and Table to generate a list of 10000
real numbers of values ranging between 1 and 20.  Using Mathematica command
ListPlot to plot the Logarithm function of this table.

(16) Make a list of 25 real random numbers chosen between 0 and a million.   Parti-
tion  the  list  in  groups  of  five.  Display  the  nested  list  with  TableForm.   Use  the
option TableSpacing to put 1 space between rows and 5 spaces between columns
and use ScientificForm to display the result keeping only 2 significant figures. 

(17)  Find all four functions that are related to the name Bessel. Use ? to find their
definitions.  Abbreviate  their  names,  such  as:  J @7 ê 2, xD  for  BesselJ[n,  x].  Make
examples with the four kinds of Bessel functions like squaring, integrating taking
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derivatives, and plotting.

(18)  In the rolling of one dies experiment, make a list of 10000 trials and find its
mean  and  plot  this  list.  From  the  first  list  make  second  list  which  represent  the
probabilities  of getting 1, 2, 3, 4, 5, and 6. Plot a bar-chart of the second list.  Be
sure  to  Load first  the  "Statistics`DataManipulation`"  ,  and  "Graphics`Graphics`"
packages.  Use  the  Random[  ]  command  to  generate  integers  1  to  6,  and  use  the
commands  Count,  Total,  Length,  and  BarChart,  and  remember  not  to  run  these
commands before loading the  needed packages. 

(19)  In  the  rolling  of  two dies  experiment,  make 10000  trials  and  make a  list  of
the sum of the two numbers obtained in each trial. Find the mean of this list, and
plot a bar-chart of the list. Be sure to Load first the "Statistics`DataManipulation`"
,  and   "Graphics`Graphics`"  packages.  Use  the  Random[ ]  command to  generate
integers  1  to  6,  and  use  the  commands  Mean,  Frequencies,  and  BarChart,  and
remember not to run these commands before loading the  needed packages.

(20)  Consider  nuclear  decay  in  a  radioactive  system.  Select  a  model  to  simulate
this radioactive system and study the radioactivity process by this model. Make a
table  of  values  for  time t,  the  number  of  radioactive  atoms at  each time,  and the
decay rate during 100 seconds interval of time. Fit these values to the exponential
behavior, and plot the decay rate as a function of time. Consider that the fundamen-
tal law of radioactivity as; the decay rate is proportional to the number of nuclei.

Note:  This problem can be modeled and simulated by considering a large identi-
cal  number  of  unstable  nuclei  n0.  We  assume  that  during  any  time  interval  Dt,
each nucleus has the same probability p  of decaying. Choose an unstable nucleus
and generate a random number r  uniformly distributed in the unit interval 0 ≤  r ≤
1.   If r ≤  p , then the unstable nucleus decays; otherwise, it does not. Every unsta-
ble  nucleus  is  tested  during  each  time  interval.  Once  a  nucleus  decays,  it  is  no
longer in the group of unstable nuclei that is tested at each time interval. 
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